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Welcome to NetWare Migration Wizard 4.0
NetWare® Migration Wizard 4.0 migrates user and group objects and data
from a Microsoft* NT* 4 or 3.51 domain to a NetWare 5.x server running
NDS®.
NOTE: This release of NetWare Migration Wizard only migrates domain
infomation from Microsoft NT. If you need to migrate data and users from NetWare
3.x or NetWare 4.x, download Novell® Upgrade Wizard at the Novell Software
Downloads Web site (http://www.novell.com/download). Documentation for Novell
Upgrade Wizard is located in the NetWare 5.1 Installation Guide (http://
www.novell.com/documentation/lg/nw51/docui/index.html).

Windows NT 3.51/4
Server
Data
File System
and
NT Objects

NetWare 5.x
Server

NetWare
Migration
Wizard

Windows NT 4.0 Workstation,
Windows NT 2000 Workstation,
or Windows NT 4.0 Server
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Migrating Data and Users from
Windows NT to NDS and NetWare
NetWare® Migration Wizard automates key tasks, such as migrating users and
their file permissions, assigning passwords, and migrating the NT file system
to a designated NDS® tree. This automation eliminates the need to choose
from various utilities that would help you perform these tasks individually.
Although many tasks are automated in NetWare Migration Wizard, you still
need to consider some issues before you get started.
First, you should plan your migration by answering the following questions:
 Which NT users are accessing which NT files and directories, and where
are those files and directories located?
This information will help you decide which NT servers to migrate first
and how many servers you will need to migrate at one time. When you
migrate your users and groups, you will want to migrate all files or
directories that they have access to at the same time that you migrate their
user objects.
 How will you handle and file or directory permissions belonging to the
trusted domains of the NT domain that you are planning to migrate?
File permissions associated with trusted domains are not migrated. You
must reassign them once the trusted domains and users have been
migrated to the destination NDS tree. Use NetWare Administrator or
ConsoleOneTM to reassign these permissions.
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 Which servers and volumes are you going to migrate your NT folders to?
You should plan which servers and volumes in your destination NDS tree
will receive each of your NT folders. You can select a separate location
for each NT folder, if desired. In order to plan effectively, you will need
to become familiar with the file structure on the NetWare servers in your
destination NDS tree.
 Which NT users and groups are you going to migrate? Which NDS
containers on the destination NDS tree are you going to migrate them
into?
Decide which NT user and groups you are going to migrate, then
determine whether you will need to create separate containers for your
NT users and groups in the destination NDS tree. When you model your
migration in the Project window of NetWare Migration Wizard, you can
create any additional NDS containers you may need by right-clicking an
NDS Organizational Unit.
 Do any existing NDS User objects represent the same person in your NT
domain?
Determine whether any of your NT users already have an NDS account.
NetWare Migration Wizard will ask you if you want to search the NDS
tree for duplicate usernames. When NetWare Migration Wizard finds
identical usernames, it will display these in a table where you can choose
to merge the listed NT user with a NDS User object if you know that they
represent the same NT user.
 What will you do with any applications that do not run on NetWare?
Most likely, you will want to find either comparable applications that run
on NetWare, or you can keep an NT server intact and use it as an
application server.
 How do you want to migrate information about your users and groups?
Do you want to use a Template object, ZENworksTM User Policy
Packages, or both?
For more information on setting up and using Template objects and
ZENworks User Policy Packages in NetWare Migration Wizard, see
“Performing Prerequisite Tasks” on page 12.
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 Do you have any trusted domains?
If so, you must reassign any trusted domain permissions to the
appropriate NT user and groups after the migration is complete. Use
NetWare Administrator or ConsoleOne to reassign all lost trusted domain
permissions.
Once you have planned your migration project, you’re ready to begin your NT
migration project. Complete the following tasks:
 Meet the system and software requirements
 Perform prerequisite tasks
 Create a migration project
 Use the Project Window to model your migration project
 Verify your migration project
 Migrate your migration project
 Complete the post-migration tasks
Continue with “Meeting the System and Software Requirements” on page 11.

Meeting the System and Software Requirements
You can run NetWare Migration Wizard either from the actual Windows* NT*
4 server that you are migrating data from or from a Windows NT 4 or
Windows 2000 workstation; however, the migration is faster if you run
NetWare Migration Wizard from the server rather than from the workstation.
The following table lists the hardware and software requirements for the
workstation or server that you are using to run NetWare Migration Wizard.
Platform

Hardware

Software

Windows NT 4 and
Windows NT 2000
workstations

 Minimum
hardware
requirements of
Windows NT
workstations

 Novell® ClientTM
for Windows NT
version 4.7 or
later
 Microsoft Service
Pack 6 or later
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Platform

Hardware

Software

Windows NT 4 server

 Minimum
hardware
requirements of
Windows NT 4

 Novell Client for
Windows NT
version 4.7 or
later
 Microsoft Service
Pack 6 or later

To download and install Microsoft Service Packs, see the ZDNet Web site
(http://updates.zdnet.com/products/pr_13616.htm).
To check your current Novell Client version, right-click the red Novell N and
select Novell Client Properties. Click the Client tab to view your current client
version.
To check the Microsoft Service Pack version, click the Start menu on the
workstation or server, select Run, and type winver in the text field.
Continue with “Performing Prerequisite Tasks” on page 12.

Performing Prerequisite Tasks
Creating a Template Object
The first prerequisite task is to determine whether you want to use a Template
object to migrate your NT users to the destination NDS tree.
A Template object is used to define additional NDS User attributes to NT
users during the migration. Template objects are especially useful for defining
similar attributes, such as fax numbers and departments. We recommend that
you use a Template object to migrate your NT users, because it is an organized
way to migrate your NT users to the NDS tree and manage them once they are
there.
NOTE: In order to migrate home directories, you must use a Template object.
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If there is a conflict between the properties of a Template object and an NT
policy, the properties of the Template object will, in most cases, take priority.
For example, if a maximum password length of seven characters is specified
for user Jeff in an NT policy and a maximum password length of nine
characters is specified in the Template object, when Jeff’s object is migrated,
the object will be created in NDS with a password length of nine characters.
If you want to know what additional NDS attributes can be defined in a
Template object, run NetWare Administrator or ConsoleOne and double-click
a Template object to view all of the existing properties.
The last name, full name, and description of every NT object is always
migrated and overwrites these corresponding properties in the Template
object. The last name of the NT user will become the NDS username after the
migration.
If you decide to use a Template object, you create one in NetWare
Administrator or ConsoleOne.
 In NetWare Administrator, right-click an NDS Organization Unit and
select Create, then click Template.
 In ConsoleOne, click File > New > Object > Template.

Installing ZENworks and Creating ZENworks User Policy Packages
The next prerequisite task is to decide whether to use ZENworks User Policy
Packages.
ZENworks User Policy Packages are geared towards controlling the
appearance and functionality of a user’s desktop. NetWare Migration Wizard
associates ZENworks User Policy Packages only with groups.
If you decide to use ZENworks, you can determine the appearance of all
workstations belonging to the users associated with a particular NDS group.
When you associate a ZENworks User Policy Package with an NDS group,
the properties you apply in the policy package allows you to control
workstation attributes such as setting a certain workstation backdrop,
restricting rights to the control panel, or modifying the workstation’s sound
and color scheme for users within that group.
NOTE: NetWare Migration Wizard does not migrate Microsoft NT 3.51 roaming

profiles.

If you decide to use ZENworks, install ZENworks Starter Pack or ZENworks
Full 2.0 in your destination NDS tree.
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See the Novell Software Downloads Web site (http://www.novell.com/
download) to download and install ZENworks Starter Pack. ZENworks Full
can be installed from the NetWare 5.0 or 5.1 product CD.
Create ZENworks User Policy Packages in NetWare Administrator or
ConsoleOne.
 In NetWare Administrator, right-click an NDS Organizational Unit in the
tree view, select Create, and then select Policy Package.
Whether you have Windows NT/2000 workstations, Windows 95/98
workstations, or both types of workstations in your NT network, will
determine whether you want to create a WINNT-2000 user policy
packages, WIN 95-98 policy packages, or both.
 In ConsoleOne, click the user policy package icon in the toolbar. If you
don’t know which icon it is, mouse-over the icons to see a short
description.
For more information about installing and using ZENworks, see the Novell
Product Documentation Web site (http://www.novell.com/documentation).

Downloading and Installing NetWare Migration Wizard
To download and install NetWare Migration Wizard, See Novell Software
Downloads (http://www.novell.com/download) > NetWare > NetWare
Migration Wizard. Follow the download and installation instructions.

Registering the Workstation
If you are running NetWare Migration Wizard from a workstation, make sure
that the workstation is registered within the domain that you want to migrate.
If this is the case, continue with “Creating a Migration Project” on page 15. If
you want to change the domain that your workstation is registered in, follow
the instructions below for Windows NT or Windows 2000.
NOTE: Do not run NetWare Migration Wizard from a Windows 95-98 workstation.

For Windows NT workstations:
1 At the workstation, right-click Network Neighborhood and select
Properties.
2 Click the Identification tab, then click Change.
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3 Click Domain, specify the appropriate domain, enter your Administration
name and password, then click OK.
4 Reboot the workstation and run NetWare Migration Wizard again, then
continue with “Creating a Migration Project” on page 15.

For Windows 2000 workstations:
1 At the workstation, right-click My Network Places, then click Properties.
2 Click the Network Identification link, then click Properties.
3 Specify the appropriate domain, then enter your Administration name and
password.
4 Reboot the workstation and run NetWare Migration Wizard again, then
continue with Creating a Migration Project.

Creating a Migration Project
Before you can begin to migrate data from NT to NetWare, you must create a
migration project.
To create a migration project:
1 First, log in to the Microsoft* NT domain as a user with administrative
rights.
2 Launch NetWare Migration Wizard from the Start menu by selecting
Programs > Novell > NetWare Migration Wizard > NetWare Migration
Wizard.
3 Click Create a New Project, then click OK.
4 Click the Microsoft NT 3.51 or 4 to NetWare 5.x option, then click OK.

You will see other migration options on this screen. All other migration
options, expect for Microsoft NT, have been grayed out and are not
available for selection at this time.
5 Review the Setup Tasks dialog box and complete all tasks if you have not
already done so, then click OK.

For additional information on how to complete these tasks, see
“Performing Prerequisite Tasks” on page 12.
6 Enter a name for your migration project, then click Next.
7 Select your destination NDS tree from the drop-down list.
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The destination NDS tree is the NDS tree that you want to migrate your
NT data to.
NOTE: If you are not logged in to your NDS tree, the NDS tree name will not

appear in the drop-down list. If this is the case, click the Browse button to log in to
your NDS tree. Once you are logged in, the NDS tree name automatically appears
in the drop-down list.

8 Verify that the NT domain that appears in the grayed-out text field is the
domain that you want to migrate, then click Next.

NetWare Migration Wizard automatically displays the NT domain that
your workstation or server is a member of.
If you are running NetWare Migration Wizard from a workstation, you
can change the domain that it is registered in. To do this, exit NetWare
Migration Wizard and follow the instructions in “Registering the
Workstation” on page 14.
9 Decide whether you want NetWare Migration Wizard to find any User
objects in your NT domain and in the destination NDS tree that have the
same name, then click Yes or No.



If you click Yes, select an NDS container on the destination NDS
tree, then click Next to begin searching for duplicate usernames.



If you click No, skip the rest of these steps and follow the instructions
in “Using the Project Window” on page 18.

10 Decide what you want to do with NT users that have the same name as
NDS users.

The following screen is an example of the username table in NetWare
Migration Wizard. Carefully review this screen. If you do not make any
changes, NetWare Migration Wizard will automatically merge the
displayed NDS user with the adjacent NT user.

16

NetWare Migration Wizard 4.0

NetWare Migration Wizard 4.0
104-001199-001
September 5, 2000
Novell Confidential

Manual

Rev 99a

28

9 June 00

You have the following three options for each listed NT user:


You can merge the displayed NDS user with the adjacent NT user. To
do this, simply leave that user displayed in the table and move on to
the next listed NT user.



You can merge a different NDS user than the currently displayed
NDS user. To do this, click the arrow by the NDS username to view
a drop-down list containing all the NDS users that have the same
username (including contexts) as the adjacent NT user. Select one of
the NDS names and move on to the next listed NT user.



You can decide to not merge any of the NDS users with the adjacent
NT user. To do this, select Don’t Merge. Select this option if you
know that none of the listed NDS users represent the same person as
the adjacent NT user.

11 Click Finish once you have made a decision for each listed NT user.

After you click Finish, NetWare Migration Wizard will automatically
place the NT users that you chose to merge in the destination NDS tree
that is displayed in the Project Window. (These NT users will
automatically appear as dropped objects in the NDS tree.)
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If you choose Don’t Merge for a listed NT user, that user will not
automatically appear as a dropped object in the destination NDS tree. If
you want to migrate these users, you must manually drag-and-drop these
NT user objects into the destination NDS tree while in the Project
window.
Continue with “Using the Project Window” on page 18.

Using the Project Window
Most of your work will be done in the Project Window. From here, you can
drag-and-drop NT user and group objects into NDS containers, and NT folders
and volumes into any volume or folder in the destination NDS tree.
The Project Window is where you will model your migration project before
you begin the actual migration. All of the planning in the Project Window is
done off-line, meaning that items moved and created in the Project Window
are not actually moved or created until you begin the migration. The Project
Window is simply a place to model different migration scenarios without
affecting your NT domain or your destination NDS tree.
The Project window and the Using the Project Window dialog box will appear
once you have created the migration project.
The following figure is an example of the Using the Project Window dialog
box. The three basic steps outlined in the Using the Project Window dialog
box should be performed for each migration project. Once you are familiar
with the tasks that you will be performing, click Close to access the Project
Window.
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Review the following tips to help you organize your migration project and use
the Project Window more effectively.
 Creating a New NDS Organizational Unit or Folder—To create a new
NDS Organizational Unit (OU), right-click the parent NDS
Organizational Unit or folder and select New Organizational Unit or New
Folder. The following figure is an example of the Project window.
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You can create new NDS Organizational Units in the NDS tree and then
migrate your NT information to those OUs. This keeps the NT
information organized and in one place in the NDS tree. You can also
choose to migrate the NT data to existing OUs. That’s fine, too; just
remember that you can always create a new OU in the NDS tree if you
need to.
If you start to add new containers or names to the destination tree, the
names you choose must adhere to the following NDS naming
conventions:
 Names must be unique. For example, Debra Jones and Daniel Jones
cannot both be named DJONES if they are in the same container.
 The following special characters are allowed only if they are
preceded by a backslash (\): plus (+), equals (=), and period (.).
 Uppercase and lowercase letters, underscores, and spaces are not
acknowledged by NDS. For example, Manager_Profile and
MANAGER PROFILE are considered identical names in NDS.
 If you use spaces, you must enclose the name in quotes when
entering it on the command line or in login scripts.
 Setting the Context—To set the context, right-click an NDS
Organizational Unit and select Set Context.
When you set the context, you can designate what part of the NDS tree
will appear in the right side of the Project Window. This is useful if you
have a large NDS tree with many objects.
Setting the context at a specific container will eliminate the need to scroll
down or collapse objects in your NDS tree. Once the context is set, this
container will appear as the top object in the right side of the Project
Window.
 Viewing a Description of the Objects in the Project Window—To see
a short description of what an icon represents in the Project window,
right-click an NDS object and select What’s This?

20
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 Backing Out a Dropped Object—To return a dropped object to the
place it previously occupied in the NT domain, right-click a dropped NT
object in the destination NDS tree and select Back Out Dropped Object.
Once an object has been dragged and dropped from the NT domain into
the NDS tree, the NT icon changes color from blue to red and a red arrow
is superimposed on the dropped object. The following screen is an
example of how a dropped object appears in the NDS tree, along with the
right-click menu.

 Finding Out Where a Dropped NT Object Came FromTo find out
where a dropped object was located in the NT domain, right-click an NT
object and select Where Did It Come From? When dragging and dropping
a large number of objects, this will help you remember where a dropped
object was previously located in the NT domain.
Once you feel comfortable with where you have dropped your NT data and
User objects in the NDS tree, verify your migration project to resolve any
potential problems before migrating your NT data.
Continue with “Verifying Your Migration Project” on page 22.
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Verifying Your Migration Project
To verify your the migration project you modeled in the Project window,
follow these instructions:
1 From the NetWare Migration Wizard toolbar, click Project > Verify
Project, or click the Verification button on the toolbar, then click Next.
2 Follow the instructions in “Migrating Your NT Users and Data to the
NDS Tree” on page 22 on page 35, starting with Step 2.

Once you have modeled your migration in the Project Window, you
should verify that the proposed locations for these new objects do not
conflict with existing names, rights, name spaces, etc. in the NDS tree.
Remember, dragged-and-dropped items appearing in the NDS tree are
merely assigned to be copied to that area in the NDS tree. Objects will not
be copied until you begin the migration process.
Because a similar verification process is run when you begin the actual
NT migration, running the standalone verification process prior to
migration is not mandatory; however, catching any critical errors or
warnings now will speed up the verification process during the migration.
You must resolve all critical errors before you begin to actually migrate
your migration project. Warnings can be resolved after the migration.
Continue with “Migrating Your NT Users and Data to the NDS Tree” on page
22.

Migrating Your NT Users and Data to the NDS Tree
NOTE: If you verified your project before you clicked the Start Migration button on
the toolbar, Netware Migration Wizard has saved your choices. You can keep the
previous settings, or you can change them during the migration process.

To migrate your file system and NT objects to the destination NDS tree:
1 From the NetWare Migration Wizard toolbar, click Project > Start
Migration, or click the Start Migration button on the toolbar, then click
Next.
2 Read the Welcome Screen and click Next.
3 (Optional) Check the check box if you want to use a Template object to
migrate your NT users to the destination NDS tree, then select the
Template object from the tree view, and click Next.
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If you do not want to use a Template object, leave the check box
unchecked and click Next.
WARNING: To migrate home directories, you must use a Template object when
migrating your NT users to the destination NDS tree.
NOTE: If you have not created a Template object but you want to use one now,

save the project, go to NetWare Administrator or ConsoleOne, and create the
Template object. Next, run NetWare Migration Wizard again and select Open Last
Project, then run the migration process again and follow these instructions starting
with Step 1.

4 Browse the destination NDS tree and select any of the ZENworks User
Policy Package that you want to associate with your NT groups, then click
Next. If you do not install ZENworks in your destination NDS tree, or if
you are not migrating any NT groups, skip to Step 7.
NOTE: If you have not created any ZENworks User Policy Packages but you want

to create and use them now, save the project, go to NetWare Administrator or
ConsoleOne, and create the ZENworks User Policy Packages. Next, run NetWare
Migration Wizard again and select Open Last Project, then run the migration
process again and follow these instructions starting with Step 1.

For more specific instructions on associating ZENworks User Policy
Packages in NetWare Migration Wizard, see “Performing Prerequisite
Tasks” on page 12.
5 Select a ZENworks User Policy Package from the drop-down list, and
then select the NT groups that you want to associate with each ZENworks
User Policy Package. Click the blue right-arrow to move the associated
groups in the Associate NT Groups window, then click Next.
HINT: If you selected both WINNT-2000 and WIN 95-98 policy packages in the
previous dialog box, you will first see one dialog box dealing only with your WINNT2000 policy packages, followed by another dialog box dealing only with your WIN
95-98 policy packages. If you selected only one type of policy package (WINNT2000 or WIN 95-98) you will only see one dialog box.

The drop-down list contains all the ZENworks User Policy Packages that
you selected in the previous step. You can associate as many NT groups
as you want with each policy package.
6 Review the NT groups that you chose to associate with specific
ZENworks User Policy Packages, then click Next.

If you want to change an association, click Back and follow the
instructions in Step 5.
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7 Decide how you want to handle any duplicate filenames between the
Microsoft NT domain and the destination NDS tree. Select one of the
following, then click Next:



Don’t copy over any duplicate filenames that are on the destination
NDS tree.



Replace any duplicate filenames on the destination NDS tree if the
source file is newer.



Always copy over the source file regardless of whether or not a file
with the same name already exists on the destination NDS tree.

8 Decide how you want to handle passwords for your NT users. Select one
of the following password options, then click Next:



Assign the Same Password to All Users—NetWare Migration
Wizard will assign and store the same password for all users in a file
named project_name_OUT.TXT. This file is saved in the same
directory that your migration project is located in.



Assign a Randomly Generated Password to All Users—NetWare
Migration Wizard will randomly generate passwords, assign them,
and then store the passwords it assigns in a file named
project_name_OUT.TXT. This file is saved in the same directory
that your migration project is located in.



Read Passwords from a file—Have NetWare Migration Wizard
migrate the current NT passwords to the destination NDS tree by
reading them from a text file.
For more information on how to create this file, click the Help
button.

9 Set NT migration options by checking or unchecking the check boxes
next to the following options:
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Migrate File Permissions—Normally, NetWare Migration Wizard
migrates file and directory permissions. If, for some reason, you want
to reassign file and directory permissions, you can choose to not copy
the file and directory permissions here and assign them later with
NetWare Administrator or ConsoleOne.



Migrate Everyone Permissions—The NDS container that you drop
the NT Domain Info object into will be assigned the Everyone
permissions. If you are migrating the Everyone permissions, be sure
to drop the NT Domain Info object high enough in the NDS tree so
that all NT users will inherit those permissions.
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HINT: Every new folder that is created in the NT domain automatically
receives the Everyone permissions by default.



Erase Information from the PDC Registry—Normally, this
information is not erased; however, if you have previously run a
migration and deleted the NDS objects from the destination tree, and
are planning on starting over and migrating the same domain again,
check this check box.
When you migrate users and groups from NT, NetWare Migration
Wizard stores a table of NT names and associated NDS usernames in
the registry of the Primary Domain Controller (PDC). NetWare
Migration Wizard then uses this information when migrating the file
system so that it can remember where each user and group has been
migrated to in the destination NDS tree. By storing this information,
NetWare Migration Wizard can assign the correct file permissions to
the appropriate users.

10 If you are not running the standalone verification process, and are actually
migrating your NT data to the destination NDS tree, skip to Step 11.

If you are running the standalone verification process, you will now see
the Check File Rights and Size dialog box. Check the check boxes if you
want to check now for sufficient file rights and size.
NOTE: Since this process is quite time-consuming, you may not want to do this

every time you verify your migration project. But it is very useful if you want to verify
that you have enough space on the destination volume to accommodate your NT
file system.

NetWare Migration Wizard will also scan the contents of all dropped
folders and verify that you have sufficient rights to migrate them.
NOTE: NT can filter supervisory privileges. If you have all rights at the root of a

directory structure, this does not guarantee that you have these rights throughout
the directory structure.

11 In the Verify NT to NetWare window, click Next to begin the verification.
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12 Verify that you do not want to migrate the listed NT users and groups,
then click Next. This procedure must be done three times—once each for
any NT local groups, NT global groups, and NT users that were not
dragged-and-dropped into the destination NDS tree. If you migrated all of
your users and groups, you will not see this dialog box.

If you have made a mistake, click Cancel. This will return you to the
Project Window. Drag-and-drop the objects, then go to the toolbar and
select Project > Start Migration. Follow the instructions in “Migrating
Your NT Users and Data to the NDS Tree” on page 22.
13 If prompted, resolve any naming conflicts between different-type objects,
then click Next.

You can choose to merge different-type objects or to keep them as they
are.
14 If prompted, resolve any naming conflicts between same-type objects,
then click Next.

You can choose to merge same-type objects or to keep them as they are.
15 Resolve any critical errors before proceeding. Warnings can be resolved
after the migration. To resolve critical errors or warnings, read the
description in the text field located beneath the errors and warning. This
description should give you a good idea of what could be the possible
cause of the error or warning and a suggestion on how to fix it.

If no errors or warnings were displayed, click Proceed to start the actual
migration.
NOTE: If you are running the standalone verification process, click Finish instead
of Proceed and follow the instructions in “Migrating Your NT Users and Data to the
NDS Tree” on page 22 to begin migrating your NT data to the destination NDS tree.

16 (Conditional) View the Error Log and the Success Log.
NOTE: Skip this step if you are running the standalone verification process.

Continue with “Completing Post-Migration Tasks” on page 27.
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Completing Post-Migration Tasks
After you’ve migrated your NT data to the destination NDS tree, complete the
following post-migration tasks:
 Install the latest Novell Client software on any workstations that it was
not previously installed on.
You can download the client from the Novell Software Download Web
site (http://www.novell.com/download). For instructions on installing the
Novell Client on multiple workstations at the same time, see Novell
Client Documentation (http://www.novell.com/documentation/lg/
noclienu/docui/index.html).
 Make sure that your NT users and groups have been migrated to the
correct place in the destination NDS tree and have the correct file and
shared permissions. Use NetWare Administrator or ConsoleOne to verify
this.
IMPORTANT: If you end up with more or fewer permissions than you planned for,

enter CACLS/? at the DOS prompt and follow the on-screen instructions.
Permissions are sometimes hidden in Microsoft utilities, thus, running this
command at the DOS prompt will allow you to see all of the permissions associated
with your NT objects, even the hidden ones.

 Make sure that your data was migrated. Go to the destination NetWare
server and use NetWare Administrator or ConsoleOne to view the volume
that you migrated your data to.
 Reassign your printer mappings in NDPS®. For instructions, see the
Novell Distributed Print Services Documentation (http://
www.novell.com/documentation/lg/nw51/docui/index.html#../
ndps_enu/data/hk4ovawv.html) Novell Product Documentation Web site
(http://www.novell.com/documentation).
 Check the migrated users’ home directories to make sure that they were
migrated the way you expected them to be.
 Distribute the new NDS passwords to all of your users. The passwords are
located in a password file that NetWare Migration Wizard created for you
named project_name_OUT.TXT. This file is located in the same directory
that you saved your migration project in.
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